
 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 9 

Compatibiliteit 
• Voor compatibiliteit met MatrixKozijn Project is minimaal  

MatrixKozijn Project 2.3.14497 SP6 vereist. 

• Voor compatibiliteit met MatrixKozijn Productentabel is minimaal  

MatrixKozijn Productentabel 2.3.14497 SP6 vereist. 

• Voor compatibiliteit met MatrixKozijn Office is minimaal 

MatrixKozijn Office 3.0.36 vereist 

• Voor compatibiliteit met MatrixKozijn Orderregistratie is minimaal  

MatrixKozijn Orderregistratie 4.0.687 SP6 vereist. 

Verbeteringen 

Algemeen 

• In de dialoog Merk verplaatsen van de merkenlijst kan nu de Enter toets op het numerieke 

toetsenbord ook worden gebruikt om de wijziging te bevestigen. Ook is voor het bevestigen nu slechts 

eenmaal Enter nodig i.p.v. tweemaal. 

 

Projecten 

• Automatisch gegenereerde toevoeging voor naam gespiegelde kozijnmerken aangepast van gesp naar 

sp. 

• Iconen voor verwijderen in de Merkenlijst hebben nu een rode kleur. 

 

Oplossingen 

Algemeen 

• De lijst met recente projecten werd niet weergegeven op de startpagina als in de bestandsnaam het 

karakter ‘ werd toegepast. 

 

Projecten 

• De contramallen uit WKV Beheer werden niet overgenomen in het project waardoor de 

werkvoorbereiding hier een foutmelding over gaf als een Contramal werd toegepast. 

• FABWindow v2: bij toepassen meerdere panelen werd bij het bepalen van de Y positie de dikte van 

het paneel een factor 10 te groot toegepast. 

• Bij het opschonen van Wissel Latten via Project Onderhoud werden alle latten opgeschoond, ook 

latten die bij kozijnmerken in gebruik waren. 

 

  



 

 

 

 

 

BIM 

• FABWindow v2: Bestanden gegenereerd met servicepack 8 bevatten soms zeer grote waarden voor 

coördinaten waardoor verder verwerken van het bestand niet mogelijk was. 

 

Calculatie  

• Aan het eind van de calculatie werden niet meer alle merken met fouten weergegeven in de 

opsomming. 

 

Werkvoorbereiding  

• Contramal figuren waarbij in de X, Y positie gebruik werd gemaakt van de variabele [r] werden niet 

correct weergegeven op de contramalstaten voor Rekwerken en Spouwlatten. 

 

 

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 8 

Compatibiliteit 
• Voor compatibiliteit met MatrixKozijn Project is minimaal  

MatrixKozijn Project 2.3.14497 SP6 vereist. 

• Voor compatibiliteit met MatrixKozijn Productentabel is minimaal  

MatrixKozijn Productentabel 2.3.14497 SP6 vereist. 

• Voor compatibiliteit met MatrixKozijn Office is minimaal 

MatrixKozijn Office 3.0.36 vereist 

• Voor compatibiliteit met MatrixKozijn Orderregistratie is minimaal  

MatrixKozijn Orderregistratie 4.0.687 SP6 vereist. 

Verbeteringen 
Werkvoorbereiding  

• Volgorde van de onderdelen op Spouwlat Contramalstaat B en C is nu gesorteerd op: breedte, hoogte, 

houtcode, nettoprofielomschrijving, detailnaam, positie.  

• Nieuw rapportsjabloon: Spouwlat Contramalstaat C.  

• Nieuw rapportsjabloon: Spouwlat Afkortstaat F.  

Oplossingen 

Algemeen 

• Tijdens het laden van bepaalde dxf blocks kon er een crash optreden. 

Projecten 

• In het dialoog projectartikelen werden wijzigingen aan een artikel niet opgeslagen als de gebruiker 

niet eerst van regel in het grid wisselde.  

• Sorteren van de gegevens in de dialoog Project Artikelen werkte niet correct.  

• MatrixXML import, importeren van tussenstijlen/dorpels werkte niet in alle situaties correct.  

• MatrixXML import, ondersteuning voor <![CDATA in node Remark. 

Werkvoorbereiding  

• Op diverse werkvoorbereidingsrapporten van Rekhout werden de variabele breedte/hoogte van de 

doorsnedefiguren niet correct afgehandeld.  

• Tijdens het genereren en opslaan van aangepaste doorsnede figuren werden de breedte en hoogte 

omgewisseld in SP6 en SP7. Gegevens opgeslagen met SP6 en SP7 moeten handmatig worden 

gecorrigeerd (breedte en hoogte omwisselen).  

• Bij het automatisch genereren van een spouwlatvorm waarbij en grote diepte werd toegepast werd er 

een extra lijn op de spouwlatdoorsnede gegenereerd met de afmeting van de diepte.  

• Genereren van contramalvorm uit Contramalfiguren werkte niet correct voor schuine 

contramalvormen. 

  



 

 

 

 

 

Bibliotheek 

• De conversie van het bibliotheek stambestand was niet mogelijk als er verwijzingen naar niet langer 

aanwezige Raam/Deur combi's aanwezig waren in de Vak Combi's.  

BIM 

• In de voorgaande build van SP8 werkte het importeren van FABWindow bestanden niet correct. 

Oorzaak was aanpassing aan de MatrixXML import.  

DXF Aanzichttekeningen 

• Bij gebruik van een aangepaste spouwlatdoorsnede en grote diepteverplaatsing werden de 

doorsnedes op de DXF aanzichten niet op de juiste locatie geplaatst.  

 

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 7 

Verbeteringen 

CNC  

• Voor de glaslatten wordt nu in de CNC resultaten opgenomen of ze binnen of buiten zitten. 

Algemeen  

• De applicatie kan meerdere keren gelijktijdig opgestart worden, de module netwerkversie moet 

hiervoor aanwezig zijn in de licentie. Hetzelfde project meerdere keren openen is niet mogelijk.  

Zie Help > Extra > ‘Command-line schakelopties’ voor meer informatie. 

Oplossingen 

Rapporten  

• Calculatierapporten met conserveringen werkten niet correct als alleen aan laag 2 en/of laag 3 een 

conserveringsartikel was toegekend. 

• De verwijzingen naar merken werkte niet op rapport Rekhout Schaafstaat A. 

• Op het rapport Kozijnconservering per merk werden merken soms dubbel vermeld met een lege 

omschrijving van de conservering.  

Productentabel  

• Als in de project artikelen de verwijzing naar het getekende artikel ontbreekt bij het gespiegelde 

artikel dan wordt geprobeerd deze verwijzing automatisch correct in te stellen gebaseerd op de 

verwijzing van het getekende artikel.  

Algemeen  

• Na het openen van diverse dialogen zoals bijvoorbeeld weergave instellingen was het mogelijk om de 

applicatie te blijven gebruiken zonder de dialoog eerst af te sluiten hierdoor werd er op een later 

moment een crash veroorzaakt. 

 

Grafische invoer  

• Als bij de weergaveopties de grafische weergave werd ingesteld op Gekleurd of Realistisch nam het 

geheugen gebruik van de applicatie toe tijdens het invoeren van kozijnen uiteindelijk traden hierdoor 

problemen op zoals onder andere: profielen in de invoer werden wit weergegeven, dialoog weergave 

instellingen (en andere dialogen) werd niet correct weergegeven, crash tijdens bewerken 

randvoorkeuzes, crash tijdens (automatisch) opslaan of sluiten van een project, crash tijdens sluiten 

van applicatie. 

• In de grafische invoer werden de rekwerk profielen niet met een gestippelde lijn weergegeven in 

recente builds.  

  



 

 

 

 

 

Calculatie  

• Voor de bestellingen van laagreliëfdorpels werden de vaksponningfiguren in geval van stolpdeuren 

niet correct gespiegeld. 

• In SP6 werd niet rechthoekig glas niet altijd correct opgenomen in de calculatieresultaten. Alleen in 

combinatie met licentiemodule 'Artikel afbeeldingen rapporten'. 

• Na het wijzigen van houtprijzen in dialoog Project->Houtprijzen en Afval werden de nieuwe prijzen 

niet direct correct toegepast in de calculatie. 

• Na dubbelklikken op de knop Genereer in de dialoog Resultaten genereren trad er een crash op.  

DXF Aanzichttekeningen  

• Bij gebruik van karakters zoals bijvoorbeeld het copyright symbool in teksten werden extra 

ongewenste karakters weergegeven in AutoCAD.  

• Werkvoorbereiding  

• Lengteberekening spouwlatten minimale en maximale lengte voor haaks en specifieke vorm werd in 

bepaalde gevallen omgewisseld.  

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 6 
 

Verbeteringen 

Rapporten  

• Op de voettekst van de werkvoorbereidingsrapporten wordt het projectnummer van de huidige serie 

weergegeven of het projectnummer van het project als er geen serie actief is. 

BIM  

• De werkvoorbereidingsstaat: Spouwlatten Contramalstaat B is aangevuld met informatie over de 

positionering en oriëntatie van het getoonde profiel en doorsnede. 

• Ondersteuning voor het importeren van kozijnen gebaseerd op het DeltaPi - Neutrale formaat 

toegevoegd. (Bètastatus)  

Productentabel  

• Artikelen met verkeerde getekende/gespiegelde artikelverwijzingen worden niet geladen uit de 

Productentabel. Een foute verwijzing is bijvoorbeeld een artikel waar meerdere artikelen als 

gespiegeld artikel naar verwijzen. In deze gevallen kan bijvoorbeeld een artikelcode in rood worden 

weergegeven in een Hang en Sluitwerk combi. In de folder %APPDATA%\Wood350 is dan het bestand 

PTTransfer.log aanwezig met een overzicht van de artikelcodes waar een probleem mee is. Deze 

artikelen moeten dan worden gecorrigeerd in de Productentabel.  

DXF Aanzichttekeningen  

• Codes met aanduiding Fase zijn nu ook te gebruiken in de stempel, de oude codes met Serie zijn ook 

nog actief. @FASECODE@, FASEOMS@, @FASEDATUM@, @FASEOPM@ en @FASEPRODUCTIENR@.  

Werkvoorbereiding  

• Bij het genereren van de contramal voor een leidende spouwlat worden nu de vorm van de 

aansluitende spouwlat en de kozijn randsponning toegepast.  

Projecten  

• Verwijderen van Verwijs Combi's bij projectartikelen was niet altijd mogelijk.  

Algemeen  

• De velden Type en Locatie uit de merkenlijst zijn nu ook beschikbaar voor de merken synchronisatie 

met MatrixKozijn Project. 

• De bepaalde windstuwdruk wordt weergegeven met precisie van 4 decimalen. 

• In de dialoog Rand Voorkeuzes is een knop 'Contramal Aanpassen' toegevoegd om de dialoog 

Contramal Figuren te openen. 

Oplossingen 

Algemeen  

• Bij het tekenen van rekwerkprofielen werd er bij bepaalde maatvoeringen een kruis getekend. 



 

 

 

 

 

Vakvoorkeuzes  

• Het gedrag van de knop 'Ga Naar' in het Vakvoorkeuzedialoog was gewijzigd in recente builds en werkt 

nu weer zoals voorheen. 

Rapporten  

• 2-lijsten-productie per project-materiaalstaat (afgeronde lengtes), bij weergave van grote aantallen 

kozijnmerken kon het voorkomen dat de aantal van een merk dubbel werden weergegeven.  

• Op rapporten waar een nieuwe sectie op dezelfde pagina kan starten als er nog voldoende ruimte is 

was er soms een overlap tussen de twee secties.  

• Handmatig toegevoegde maatlijnen bij de randdetails werden niet altijd op de correcte positie 

geplaatst op de werkvoorbereidingsrapporten.  

BIM  

• FABWindow v2, aangepaste schuine contramalvormen (drie punten) werden niet altijd correct 

gegenereerd in het export bestand, de oriëntatie van de vorm was geroteerd.  

• DeltaPi import, De Matrix3D informatie uit het bronbestand wordt vertaald naar de positionering en 

rotaties voor FABWindow v2. Het eindresultaat wijkt af, de rotaties zijn niet exact. (Meer informatie 

opgevraagd bij DeltaPi per e-mail 18 januari 2019)  

• DeltaPi import, de bestandsextentie voor DeltaPi bestanden is ingesteld op .ProjectDataFile  

• DeltaPi import, er wordt een kozijnmodel aangemaakt gebaseerd op de aangegeven bounding box in 

het bronbestand.  

Grafische invoer  

• Het wijzigen van de profielpositie van profielen in een Samengestelde Profiel Combi was niet mogelijk 

via het eigenschappen venster.  

• Het eigenschapsvenster toonde bij samengestelde profielen niet altijd de correcte doorsnedenaam, 

deze week dan af van de doorsnedenaam die op de tekening zelf werd weergegeven.  

• Bij driezijdige ramen werd voor bepaalde hoeken een gedeelte van de knooppunten niet correct 

weergegeven.  

• Na wijzigen van de maatvoering werd in bepaalde situaties de toog die aan de rand was toegekend 

verwijderd.  

Calculatie  

• Het automatisch opzoeken van het juiste neut artikel gebaseerd op de gebruikte vak en 

randsponningen werkte niet correct bij stolpstellen. Bijv. hefschuifdeur met verschillende neut voor 

vast en schuif gedeelte.  

Bibliotheek  

• Bij converteren stambestanden uit 3.2 of 3.4 werden de afmetingen van de profiel combies niet 

correct gevuld in recente builds.  

DXF Aanzichttekeningen  

• Unicode karakters zoals é werden niet meer weergegeven op de aanzichttekeningen.  

CNC  

• De actieve Resultaten Filters veroorzaakte foutmeldingen tijdens de CNC export.  

• Velden voor opslag van de Conservering omschrijving vergroot van 50 naar 255.  



 

 

 

 

 

• Er kon een crash optreden tijdens de export CNC bij het bepalen van de verbindingsinformatie voor 

glaslatten.  

Werkvoorbereiding  

• De maatlijn voor schuine contramallen werd niet altijd gegenereerd.  

• Tijdens het genereren van resultaten voor toogkozijnen met een spouwlat kon er een crash optreden.  

• Bij het wijzigen van de breedte van een sponningfiguur node kon er een crash optreden.  

• Spouwlatten en wisselsponningen werden in bepaalde situaties niet correct geroteerd op de 

detailrapportages.  

• Randdetail blocks werden niet altijd correct gespiegeld of geroteerd op de dxf uitvoer.  

• Op de werkvoorbereidingsrapporten is het nu mogelijk om de opties height="automatic" en 

newpageonchangeof="[..]" tegelijkertijd te gebruiken.  

• De weergave van stippel/streeplijnen op het profiel (bijv. Spouwlat Contramalstaat C) werkte niet 

correct voor de positie Onderdorpel.  

• Opslag haakse contramallen spouwlatten was niet altijd consequent waardoor deze niet op de 

rapporten bij elkaar werden gegroepeerd.  

• Bij het bepalen van de additionele lengte voor spouwlatten bij aansluiten op een aangepaste 

doorsnede word nu de vorm de doorsnede in acht genomen, dit was niet in alle situaties het geval. 

Projecten  

• Bij het importeren van een kozijnmerk uit een merkenbibliotheek werd de inhoud van Samengestelde 

Profielen niet altijd correct gevuld.  

• De actie 'Update Prijzen' in de dialoog 'Project Artikelen' voerde de update van de prijs niet door bij de 

project artikelen.  

• Bij de actie Opschonen in de Project Onderhoud dialoog werden in bepaalde situaties Project Artikelen 

die nog in gebruik waren toch verwijderd.  

• Bij het achter elkaar wijzigen van eigenschappen van meerdere artikelen in de project artikelen 

dialoog werden sommige wijzigingen niet opgeslagen.  

• Als een project is opgeslagen door een nieuwere versie of servicepack en de huidige geïnstalleerde 

versie het project niet meer goed kan verwerken dan wordt er voortaan een melding weergegeven: 

'Dit project is opgeslagen door een nieuwere versie of servicepack van MatrixKozijn en kan niet meer 

worden geopend met deze versie, installeer de meest recente versie van MatrixKozijn.' 

MatrixKozijn Hout versie 3.5 - Service Pack 5 
 

Verbeteringen 

Werkvoorbereiding  

• Nieuw rapport Spouwlatten Contramalstaat C, gelijk aan Contramalstaat B met aangevuld de posities 

en aansluitingen bij de doorsnede en contramallen.  

Algemeen  

• In het onderdeel CE zijn voor de eigenschappen Waterdichtheid en Lucht Doorlatendheid de keuzes 

E650 tot en met E3000 toegevoegd.  



 

 

 

 

 

• De knop 'Vernieuwen' is niet meer aanwezig op de artikel/activiteit selectie dialoog. Gegevens 

vernieuwen/opnieuw ophalen uit de productentabel is nu alleen nog mogelijk vanuit het hoofdscherm 

van de applicatie. 

• De sortering van de onderdelen in de meeste dialogen is nu standaard op de kolom Code (weergave 

onderdelen Code en Omschrijving) bij nieuwe installaties. 

• De standaard breedte van de kolommen code/omschrijving van de standaard dialogen met links een 

lijst bij een nieuwe installatie is verbeterd, zodat de code en omschrijvingen direct leesbaar zijn. 

• Als er bij het aanmaken van een nieuwe vakvoorkeuze wordt gekozen om ook automatisch een 

nieuwe Vak Combi aan te maken en er bestaat reeds een Vak Combi met de aangegeven code dan 

wordt er een melding weergegeven dat de bestaande Vak Combi is toegekend.  

• De lijst met certificaten was niet geselecteerd in de keuze lijsten van de dialoog Merk Certificaten 

Toekennen.  

Rapporten  

• Als de optie CE was uitgeschakeld voor een merk dan werden er toch CE etiketten gegenereerd en was 

het merk zichtbaar op de prestatieverklaring.  

• Nieuw rapport 4-overzichten-uwaarde_gemiddeld, dit rapport geeft de gemiddelde U-waarde van de 

huidige set calculatieresultaten.  

• De lijst met calculatierapporten was niet meer gesorteerd op de kolom sorteervolgorde in sp4. 

• De boomweergave links van de calculatierapport voorbeeld weergave en die in de dialoog Calculatie 

Rapporten gebruiken nu dezelfde instelling. Na wijzigingen in de dialoog Calculatie Rapporten wordt 

de boomweergave in het voorbeeld ook op die manier weergegeven.  

Grafische invoer  

• Bij toekennen van Rand Knooppunt Sjablonen werden ook de Project Randvoorkeuzes aangepast ook 

als de Rand van het huidige kozijnmerk niet meer werd gedeeld. 

• De conservering kleur wordt weergegeven voor Panelen en Rabat/Schrootjes als deze optie aanstaat 

bij de weergave instellingen. 

• Tijdens bewerken van de maatvoering was niet altijd het eerste karakter zichtbaar bij afmetingen van 

1000 en hoger.  

• De waarde van het vinkje Rand Knooppunt Sjabloon Toepassen in de dialoog Merk Sjabloon Toepassen 

werd niet correct gecontroleerd waardoor het geselecteerde Randknooppunt Sjabloon altijd werd 

toegepast.  

• Als de optie 'Toon kleur van de conserveringen' actief is bij de weergave instellingen dan worde nu ook 

de panelen in de conserveringskleur weergegeven.  

Calculatie  

• Op een aantal begrotingsrapporten worden artikelen en activiteiten met aantal=0 niet meer 

weergegeven. 

• Als er gebruik werd gemaakt van manuur coëfficiënten en tijdcorrecties werden de manuren niet op 

de juiste manier berekend op een aantal calculatierapporten.  

• Gebruik van Verwijs Combies in combinatie met de calculatieregel Vaste Maat werkte niet correct. 

• De controle op minimaal/maximaal toegestaan oppervlak van de Hang en Sluitwerk Combi's werkte 

niet correct. 

• Voor kozijnmerken met een rekwerk onder de laagreliëfdorpel werd een extra profielzijde gegeneerd 

in de elektronische bestelling van Laagreliëfdorpels. 



 

 

 

 

 

• De gegenereerde sponningen voor het elektronisch bestellen van Laagreliëfdorpels waren niet altijd 

correct voor stolpvakken. 

DXF Aanzichttekeningen  

• De waarde Positie naast Profiel voor de weergave van de Randvoorkeuze Code in het aanzichttekening 

sjabloon werd niet correct opgeslagen.  

• Uit de dialoog Resultaten Genereren is het tabblad Aanzichten verwijderd. De aanzichten worden nu 

gegenereerd gebaseerd op de geselecteerde kozijnmerken in het tabblad Selectie.  

Werkvoorbereiding  

• De contramal van een spouwlat die aansluit op een spouwlat met een aangepaste doorsnede was niet 

in alle situaties gebaseerd op de vorm van deze aangepaste doorsnede.  

• Diverse problemen gerelateerd aan het genereren van contramalvormen voor de spouwlatten en 

rekwerkprofielen gecorrigeerd. 

• Als bij een spouwlat was aangegeven dat er een specifieke contramalvorm moest worden toegepast 

dan werd deze contramalvorm niet altijd op de werkvoorbereidingsrapporten weergegeven.  

Projecten  

• Als de artikelcode van projectartikelen werd gewijzigd dan werd deze wijziging ook doorgevoerd in de 

kozijnmerken waarin dit artikel was toegepast.  

• Het onderdeel Variabele Houtsoorten is toegevoegd bij het Project Onderhoud.  

• Wijzigingen in de volgorde van de Fases (omhoog/omlaag actie) werden niet altijd correct opgeslagen. 

• De performance tijdens onderdelen verwijderen in de weergave Conserveringen is verbeterd.  

BIM  

• FABWindow v2, de material node voor conserveringen werd niet opgenomen in het export bestand 

voor tussenstijlen/dorpels van ramen/deuren. 

• FABWindow v2, de afmeting van de start/eind contramal van de spouwlat werd niet altijd 

meegenomen in de totaallengte van de spouwlat. 

• FABWindow v2, de start- en eindcontramal van de spouwlatten werden soms verwisseld. 

• FABWindow v2, de oriëntatie van tussenstijlen/dorpels binnen ramen/deuren was niet altijd correct 

(zowel de X als de Z konden fout zijn).  

• FABWindow, de hoogte van het glas werd niet gecorrigeerd met de afmeting van het ventilatierooster. 

Vakvoorkeuzes  

• Het was in recente releases niet meer mogelijk om de omschrijving van een Vakvoorkeuze met spaties 

te laten starten. 

• Ingevoerde decimalen bij de correcties in het tabblad Voorkant en Achterkant van de Paneel/Rekwerk 

Vakcombi's werden niet opgeslagen.  

Bibliotheek  

• In de grid weergave van de dialoog Profiel Combies werden wijzigingen niet opgeslagen als er van F10 

of control-C/V gebruik werd gemaakt. 

• Onderdelen verwijderen uit het laagreliëf grid van de vaksponningtabellen was niet mogelijk. 

• De performance tijdens het kopiëren/plakken van artikellijsten in de dialoog Rand Voorkeuzes is 

verbeterd.  

• DXF Aanzichttekeningen  



 

 

 

 

 

• Niet alle onderdelen uit blocks werden correct weergegeven in servicepack 4. 

• Laaginstellingen uit het tabblad kolommen van de Aanzichttekening Sjablonen werden leeg als het 

sjabloon werd geopend door een gebruiker zonder rechten om de sjablonen te wijzigen. 

• Tijdens kopiëren van een aanzichttekeningsjabloon werd de bestandsnaam van het sjabloon niet 

correct samengesteld (2x de aangegeven omschrijving in de bestandsnaam). 

• De afmeting van neuten werden niet altijd correct weergegeven op de aanzichttekeningen. Er werd 

dan bijv. 3232 i.p.v. 32 weergegeven.  

CNC  

• De verbindingslengte van doorlopende profielen was niet altijd correct bij raam/deurprofielen waarbij 

afwijkende maten voor de linker en rechterstijl werden toegepast. 

• De resultaten van driezijdige vakken konden niet altijd worden gegenereerd, de raam/deurprofielen 

en glaslatten ontbraken.  

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 4 

Verbeteringen 

Rapporten  

• De afmeting van de dialoog Calculatie Rapporten (Selectie) is instelbaar gemaakt.  

Grafische invoer  

• Het object Text uit de Hang en Sluitwerk blocks wordt nu weergegeven in de grafische invoer en de 

bitmap afbeeldingen. Voorheen werd alleen MText weergegeven.  

Bibliotheek  

• Er is een nieuwe gebruikersrecht 'Bibliotheek - Rand Knooppunt Sjablonen' voor toegang tot de 

desbetreffende dialoog. Het gebruikersrecht kan worden toegekend in MatrixKozijn Database Beheer.  

Algemeen  

• De applicatie 'Conversie Instellingen' kan nu ook de instellingen van MatrixKozijn Hout 3.2 direct 

converteren. Let op dat voor deze actie de applicatie met administrator rechten gestart moet worden 

(rechtermuis knop 'Als administrator uitvoeren'). Voor conversie vanuit MatrixKozijn Hout 3.4 is het 

niet nodig om de applicatie met administrator rechten te starten.  

Oplossingen 

Rapporten  

• Het werkvoorbereidingsrapport Kozijn Schaafstaat B kon niet worden gebruikt.  

BIM  

• FABWindow v1, de posities en richtingen van spouwlatten in het v1 formaat waren niet correct. 

• FABWindow, de orientatie (breedte en hoogte) van stijlen/regels van rekwerken was niet altijd 

correct.  

Grafische invoer  

• Tijdens aanpassen van eigenschappen in een vak kon het voorkomen dat de draairichting in een ander 

vak binnen hetzelfde merk automatisch werd gewijzigd. 

• Bij bepaalde werkwijzen trad er een crash op in de applicatie bij dubbelklikken op een vak om de 

vakvoorkeuze te openen. 

• De keuzelijst voor Profiel Combi's in de Randvoorkeuze Dialoog toont nu de Profiel Combi's uit 

Bibliotheek en Project. 

• Bij Toepassen Merk Sjabloon werd niet altijd het geselecteerde Rand Knooppunt Sjabloon toegekend. 

• In de dialoog Merk Sjabloon Toepassen werd het laatst gebruikte Rand Knooppunt Sjabloon niet 

onthouden. 

• FABWindow v2, de punten voor de draairichtingen werden niet in de juiste volgorde in het export 

bestand geplaatst. 



 

 

 

 

 

• Tijdens het toepassen van een Rand Knooppunt Sjabloon werden Laagrelief Dorpels in een 

Samengestelde Profiel Combi niet gedetecteerd. 

• Als de lijst met project onderdelen is uitgeklapt in de vak/rand voorkeuze selectie dialoog dan blijft 

deze uitgeklapt na wisselen tussen bijv. de merkenlijst en de grafische invoer. 

• Het geselecteerde tabblad (bibliotheek/project) in de stappen Vakken en Randen werd niet 

onthouden. 

• Spouwlatten werden niet correct weergegeven bij een getoogde bovendorpel. 

• Tijdens het toekennen van stolp Vak Voorkeuzes trad er in bepaalde gevallen een crash op in 

MatrixKozijn. 

• In de invoerstap Randen werden de hotspots van de randen niet weergegeven als de muiscursor over 

het onderdeel werd geplaatst.  

Calculatie  

• De prijscorrecties werden niet correct weggeschreven in de resultaten na het openen van meerdere 

projecten achter elkaar zonder de applicatie tussentijds te sluiten. 

• Calculatieresultaten en Rapporten ondersteunen langere omschrijvingen van Leveranciers en 

Conservering Combi's, beide 255 karakters. 

• De calculatie Algemene Kosten per artikelgroep werkte niet foutloos, de aangegeven merkaantallen 

werden niet correct toegepast. 

• Wijzigingen in de font instellingen bij Resultaten Genereren->Afbeeldingen werden pas toegepast na 

opnieuw starten van de applicatie. 

• In de dialoog Calculatie Rapporten worden op de tabbladen Artikelgroepen en Leveranciers alleen 

onderdelen weergegeven die in de huidige calculatieresultaten aanwezig zijn. 

• De berekende espagnolet posities voor de export van laagreliëfdorpels was niet correct voor 

gespiegelde kozijnen. 

• In SP3 werd niet rechthoekig glas niet opgenomen in de calculatieresultaten.  

Bibliotheek  

• Tijdens het wisselen tussen Paneel/Rekwerk Combi’s werd de inhoud van het tabblad Rekinhoud niet 

correct geïnitialiseerd. 

• De maximaal in te voeren lengte van Codes (25 karakters) werd niet correct gecontroleerd tijdens 

bewerken van de bibliotheek onderdelen. 

• Het vervangen van Hang en Sluitwerk Combi's in Bibliotheek en Project werkte niet. 

• FABwindow, stijlen/regels van panelen/rekwerken met kleine breedte of hoogte maat werden niet 

opgenomen in het IFW bestand. 

• In de dialogen Algemene Kosten werkte het vinkje Blokkeren van de groep niet correct, de onderdelen 

van de groep werden aan/uitgevinkt. 

• De actie Update uit Bibliotheek werkte niet correct in servicepack 3 voor de Profiel Combi's.  

DXF Aanzichttekeningen  

• Doorsnedes op de aanzichttekeningen werden soms gespiegeld weergegeven. 

• Het weergeven van decimalen voor de maatlijnen op de aanzichttekeningen werkte niet correct. 

• De spouwlatlengte werd niet altijd weergegeven gebaseerd op de posities van de aansluitende 

spouwlatten.  



 

 

 

 

 

Werkvoorbereiding  

• De rotatie van aangepaste spouwlatdoorsnedes was niet consequent op de 

werkvoorbereidingrapporten. 

• Centreren van de details op de werkvoorbereidingrapporten in verticale richting werkte niet correct in 

combinatie met weergeven van de maatvoering. 

• Bij gebruik van netto profielen met een gelijke omschrijving maar een afwijkende code werden er op 

rapportages soms dubbele aantallen afkortlengtes gegenereerd. 

• Het bepalen van de spouwlatlengte werkte niet altijd correct als de spouwlat aansloot op een 

aangepast doorsnede figuur. 

• Verwijderen van namen van sponningfiguren in het Werkvoorbereidingbeheer was niet mogelijk.  

Projecten  

• De inhoud van de dialoog Project Artikelen werd soms leeg weergegeven. 

• Het doorvoeren van wijzigingen aan geselecteerde Hang en Sluitwerk Combi's in Project 

Vakvoorkeuzes werkte niet correct. 

• Bij het aanmaken van een nieuwe project vakvoorkeuze met een code die reeds als project 

vakvoorkeuze aanwezig is werd de omschrijving niet automatisch ingevuld in de dialoog waar de 

gebruiker de nieuwe unieke code kan opgeven. 

• De functie project functie 'Update uit Stambestanden' werkte niet correct voor het onderdeel Profiel 

Combi's de wijzigingen werden niet correct doorgevoerd afhankelijk van de werkwijze. Bijv. Project 

Onderhoud->Profiel Combi's->Update uit Stambestanden, de wijzigingen werden niet correct 

doorgevoerd in het project. 

• Tijdens het importeren van merken uit een kozijnbibliotheek werden de toegekende merk certificaten 

niet mee geïmporteerd. 

• Nieuw toegevoegde Resultaten Filters aan de bibliotheek werden niet automatisch toegevoegd aan 

bestaande projecten. 

• Tijdens het invoeren van gegevens in het grid Conserveringen werden de kolommen niet op de juiste 

manier ververst. 

• De functie 'Doorsnede aanpassen' bij de spouwlatten werkte niet correct als er lange Rand Voorkeuze 

Codes werden toegepast. Er werd dan geen code voor het doorsnedefiguur gegenereerd.  

Algemeen  

• Het starten van een nieuw MatrixKozijn project via MatrixProject werkte niet altijd correct als de 

MatrixKozijn applicatie niet tussentijds werd afgesloten. 

• Tijdens het converteren van de bibliotheek uit versie 3.4 werd de waarde 'Dit sjabloon automatisch 

toekennen aan nieuwe projecten' van de Algemene Kosten Sjablonen niet correct overgenomen. 

• Projecten met karakters als ^ in de bestandsnaam waren niet selecteerbaar in het startscherm van 

MatrixKozijn. 

• WKV Beheer, Sponningfiguren->Naamgeving, het was niet mogelijk om alle namen bij een 

sponningfiguur te verwijderen. 

• De functie Archief maken voor Support werkte niet op 32-bit besturingsystemen. 

• Tijdens het bewerken van Namen Kozijndoorsnedes in WKV Beheer kwam er soms een foutmelding 

over waardes die reeds bestaan. 

• Bij aanmaken nieuwe projecten van Orderregistratie werden niet de standaard onderdelen zoals bijv. 

Algemene Kosten aan het project toegekend. 

• Links van recente projecten op de startpagina werkten niet bij gebruik van unc namen.  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 3 
 

Verbeteringen 

Rapporten  

• Spouwlat Contramalstaat B, De verticale uitlijning en verschaling van het profiel en de doorsnede is nu 

altijd voor beide hetzelfde. 

• Spouwlat Contramalstaat B, De oriëntatie van doorsnedes van horizontale latten is aangepast naar 

horizontaal. 

• Spouwlat Contramalstaat B, Te kepen gebied aan de onderzijde van een verticale lat wordt aan de 

linkerzijde op de profielafbeelding weergegeven. 

• Spouwlat Contramalstaat B, Voor verticale latten wordt de contramal aan de onderzijde altijd links op 

de profielafbeelding weergegeven. 

• Rapport Spouwlat Contramalstaat A SP toegevoegd.  

BIM  

• FABwindow, ondersteuning uitvoer van glaslatten voor niet vierzijdige vakken is toegevoegd. 

• Tijdens het importeren van een FABwindow bestand worden de project eigenschappen van het 

huidige project niet meer overschreven met de gegevens uit het FABwindow bestand.  

Gedeelde Vakken en Randen  

• Rand Voorkeuzes, Project, wijzigingen voor de instellingen voor verbindingen in een Project Rand 

Voorkeuze worden ook toegepast op de Rand Voorkeuze in de merken. 

• Rand Voorkeuzes, Project/Bibliotheek, de instellingen voor knooppunten zijn in de voorkeuze op te 

geven voor start en einde van de spouwlat.  

Calculatie  

• Bij de Algemene Kosten is het nu mogelijk om in de kolom 'Berekenen over' de subtotalen van een 

artikelgroep te gebruiken. Er kan per artikelgroep worden gekozen voor Totaal Artikelen, Totaal 

Activiteiten of Totaal Artikelen en Activiteiten.  

Vakvoorkeuzes  

• Tijdens conversie van de stambestanden en projecten wordt voor vakken met de draairichting 'Vast' 

automatisch de keuze 'Niet weergeven draairichting op tekening' ingesteld op waar.  

Bibliotheek  

• De gebruikersinterface van het onderdeel Bruto Houten Profiel in de Profiel Combi dialoog is 

verbeterd, de codes en omschrijvingen van de onderdelen zijn nu in zijn geheel zichtbaar.  

Projecten  

• Nieuw ingevoerde sponningfiguren in Werkvoorbereidingbeheer waren niet direct zichtbaar/te 

gebruiken in het geopende project. De functie 'Verversen Artikelen/Activiteiten uit Productentabel' is 

uitgebreid zodat ook de gegevens van sponningfiguren worden ververst. Hierdoor is het niet meer 

nodig eerst het project te sluiten en weer te openen. 

• De kolom gewicht is toegevoegd bij de project artikelen.  



 

 

 

 

 

Algemeen  

• Breedtes van kolommen in grids werden niet onthouden als de kolom erg breed was ingesteld. 

• Als bronbestanden voor de stambestand en projectconversie is het nu ook mogelijk om MatrixKozijn 

Hout versie 3.2 bestanden te selecteren  

Oplossingen 

Rapporten  

• Op een aantal rapporten was de totaaltelling m2 glas niet in alle situaties correct.  

BIM  

• De export naar FABwindow v1 werkte niet, het programma kwam in een oneindige loop en er werd 

hierdoor een groot export bestand gegenereerd.  

Gedeelde Vakken en Randen  

• Tijdens het importeren van kozijnmerken werden additionele Project Rand Voorkeuzes aangemaakt 

terwijl er al Project Rand Voorkeuzes met de juiste code aanwezig waren.  

Grafische invoer  

• Text gebruikt in DXF blocks van het Hang en Sluitwerk werd zeer klein weergegeven in de grafische 

invoer. 

• De sortering van de houtsoorten in de Profielenboom was niet gebaseerd op het veld Code van de 

Variabele Houtsoorten.  

Calculatie  

• Tijdens het ophalen van calculatiegegevens door MatrixProject werden de actieve calculatieresultaten 

filters in het project niet toegepast.  

Vakvoorkeuzes  

• De optie 'Toestaan' in de Vak Voorkeuzes bij Hang en Sluitwerk Keuzes werd niet correct afgevangen 

in het eigenschappen venster tijdens de grafische invoer. 

• Het was soms niet mogelijk om onderdelen te selecteren in keuzelijsten van de vakvoorkeuze dialoog, 

de keuzelijst reageerde niet op de muisklik.  

Bibliotheek  

• Bij diverse Combi's waren in de keuzelijsten voor Verwijs Combi's niet alle typen beschikbaar.  

DXF Aanzichttekeningen  

• Tijdens het genereren van aanzichttekeningen voor merken met een samengestelde profielcombi 

waarbij een laagreliëfdorpel en een houten profiel elkaar overlappen kon er een crash optreden.  

Werkvoorbereiding  

• Bepalen van de lengte van spouwlatten waarbij het contramal figuur vlak is werkte niet altijd correct. 

• Detectie spouwlat kepen ter plekke van een laagreliëfdorpel werkte niet als de laagreliëfdorpel via een 

samengestelde profiel combi was toegekend.  



 

 

 

 

 

Projecten  

• Het automatisch opzoeken van het benodigde neutartikel aan de hand van de sponningen links/rechts 

werkte niet. 

• Het was niet mogelijk om prijzen voor bijv. kostenplaatsen vast te zetten in het project als de prijs 

gelijk was aan de prijs van de productentabel. Dit probleem is verholpen en de gebruikersinterface in 

de desbetreffende dialogen is aangepast om inzichtelijker te maken welke prijzen van toepassing zijn. 

Dialogen: Kostenplaatsen, Prijscorrecties en Houtprijzen en Afval. 

• Tijdens het importeren van een Raam/Deur Combi toegepast in een stolpraam werden de profielen 

links/rechts omgewisseld. 

• Fases invoer, de kleur van de kolommen als het aantal beschikbaar kleiner was als 0 werd niet correct 

ingesteld op rood. 

• Tijdens de conversie van projecten werden de toegekende merk certificaten niet overgenomen. 

• Tijdens het bewerken van doorsnede of contramal figuren werden de maatlijnen soms in een te groot 

lettertype weergegeven.  

Algemeen  

• Tijdens het uitwisselen van gegevens tussen MatrixKozijn Orderregistratie en MatrixProject werden de 

tijdelijke projectbestanden in de Windows temp folder niet opgeruimd. 

• Als bij een spouwlat een correctie lengte werd opgegeven dan werd de spouwlat op tekening alleen 

inclusief die lengte weergegeven als er een aansluitende spouwlat aanwezig was. 

• Verwijs Combi’s met alleen artikelen of activiteiten werden niet getoond in de selectielijsten in 

MatrixKozijn. 

• Het was mogelijk om in het project/bibliotheek onderdelen te verwijderen die nog in gebruik waren in 

andere dialogen.  

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 2 

Verbeteringen 
 

DXF Aanzichttekeningen  

• Knooppunten van tussenstijlen/dorpels in deuren/ramen worden nu weergegeven als in het 

Aanzichttekening Sjabloon de optie Stijl->Weergave Knooppunten->Raam/Deurprofielen actief is.  

Projecten  

• Als een nieuw doorsnede of contramal werd aangemaakt via de stappen Project->Paneel/Rekwerk 

Combi's->Doorsneden/Contramallen dan was het niet mogelijk deze nieuwe onderdelen direct te 

selecteren in het grid met profielen, de dialoog moest dan eerst worden afgesloten en opnieuw 

geopend. 

• De grootte van de dialoog Project Onderhoud is door de gebruiker aan te passen. 

• In de Project Onderhoud dialoog wordt er een melding weergegeven na de acties Opschonen en 

Update uit Stambestanden. 

• Er wordt een melding weergegeven als de actie Verversen Artikelen/Activiteiten uit centrale 

productentabel is uitgevoerd.  

Algemeen  

• De draairichting 'Vast' wordt weergegeven op tekening als kruis. Tekenen van de draairichting kan 

onderdrukt worden middels de instelling 'Niet weergeven draairichting op tekening' in de vakcombi.  

Oplossingen  

Projecten  

• Bewerken en opslag van gegevens in de dialoog Project->Houtprijzen en Afval werkte niet correct.  

Rapporten  

• De streepjescode van de rapporten met het projectnummer van de fase in de voettekst als 

streepjescode werkte niet correct door het ontbreken van * voor en achter het projectnummer in de 

streepjescode.  

BIM  

• FABwindow v2, in bepaalde situaties werd de eindpositie van een partshape buiten het profiel 

geplaatst waardoor er tijdens het assembleren in Revit een fout omtrent een Vector ontstond.  

Grafische invoer  

• Als aan een profiel een specifiek sponningfiguur was toegekend en dit figuur was niet meer aanwezig 

in Werkvoorbereiding Beheer dan was het niet mogelijk het toegekende sponningfiguur te selecteren 

of te verwijderen. 

• Invoerstap - Randen, als er een rand zonder spouwlat werd geselecteerd dan werd deze rand niet 

aangegeven als geselecteerd door het weergeven van een rode lijn ter plaatse van de rand. 



 

 

 

 

 

• De weergave instellingen voor Randen waren niet altijd in te stellen. 

• Tooltips van de warmteoverdracht werden niet altijd weergegeven bij gebruik van de nieuwe knop om 

snel te wisselen tussen de warmteweergave aan/uit. 

• Na het kiezen van een standaard kozijnvorm voor een bestaand merk werden de merk posities van het 

merk verwijderd. 

• Bij het Toekennen van een merksjabloon werd een willekeurig sjabloon toegekend in plaats van het 

door de gebruiker geselecteerde merksjabloon. 

• De dialoog Merksjabloon Toekennen reageert ook weer op de Enter toets van het numerieke 

toetsenbord.  

Calculatie  

• De slechts presterende CE waarde voor een merk werd niet correct bepaald voor Waterdichtheid (1A-

9A), Weerstand Windbelastingen (C5-A1) en Lucht Doorlatendheid (1-4). 

• Als er in de invoerstap Werkvoorbereiding een alternatief sponningfiguur was geselecteerd voor een 

profiel dan werd dit sponningfiguur niet opgenomen in de bestellingen voor Laagreliëfdorpels.  

• Als een Resultaten Filter in het project werd aangepast dan werden de aanpassingen niet direct 

toegepast tijdens de calculatie van het project.  

DXF Aanzichttekeningen  

• Op de aanzichttekeningen werd de peilmaat van het voorgaande merk afgebeeld bij merken zonder 

een peilmaat.  

Werkvoorbereiding  

• De ingevoerde correctielengte voor spouwlatten werd dubbel toegekend aan de resultaten. 

• De lijst met sponningfiguren in de dialoog Werkvoorbereiding Beheer->Wisselsponning Contramal 

Prioriteiten werd in de omgekeerde volgorde weergegeven. Nu worden de sponningen met de 

hoogste prioriteit weer bovenaan de lijst weergegeven. 

• Het was niet mogelijk gegevens in te voeren in Werkvoorbereiding Beheer->Namen Kozijndoorsnedes.  

Projecten  

• Er trad een crash op als van een merk eerst de omschrijving werd verwijderd en vervolgens werd 

geprobeerd het merk te verwijderen. In de merkenlijst, selecteer een merk, kolom omschrijving, 

delete (omschrijving wordt nu leeg), x op de knoppenbalk om het merk te verwijderen. 

• Splitsen van een glasvak in een raam of deur leverde in bepaalde situaties een crash op. 

• Het was mogelijk om Roede Combi's die in gebruik waren in een vak te verwijderen uit het project.  

Algemeen  

• Het laden van Hang en Sluitwerk blocks werkte niet correct als de bron DXF bestanden in een folder 

stonden met karakters als á in de foldernaam.  

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Service Pack 1 

Verbeteringen 

Rapporten  

• Nieuwe rapporten layouts toegevoegd waarbij de streepjescode is gebaseerd op het project nr dat is 

ingevoerd bij de gecalculeerde serie. Extra->Instellingen->Calculatie Rapporten->Layout: 'Fase 

Standaard met streepjescode' en 'Fase Gelijke project en offertenummering met streepjescode'.  

Grafische invoer  

• In de grafische invoerstappen is een knop toegevoegd om de weergave van de warmteoverdracht 

eenvoudig aan/uit te zetten.  

• Als de weergaver optie 'Toon kleur van de conserveringen' actief is dan worden ook de spouwlatten 

nu in de juiste kleur weergegeven.  

Algemeen  

• De term 'Invoer Filter' in de gebruikersinterface is aangepast naar 'Fase Filter'. 'Invoer Filter' volstond 

niet meer omdat de selectie ook op de uitvoer van toepassing is. 

• De term 'Series' in de gebruikersinterface is aangepast naar 'Fases' zodat dit overeenkomt met 

MatrixKozijn Project. 

• De kolom Omschrijving wordt niet meer weergegeven in de export dialoog.  

Oplossingen  

Rapporten  

• Diverse rapporten gaven foutmeldingen tijdens het weergeven.  

Grafische invoer  

• Het laatst gebruikte Merk Sjabloon werd niet automatisch geselecteerd voor toekennen bij openen 

van de dialoog Merk Sjabloon Toekennen. 

• Na bewerken van een Project Vakvoorkeuze (Bijv. een wijziging in de gebruikte Vaksponning tabel) kon 

er een crash optreden bij afsluiten van de dialoog Vak Voorkeuzes. 

• In de invoerstap Randen werden niet altijd linksonderin de eigenschappen weergegeven van de 

geselecteerde rand.  

Vakvoorkeuzes  

• Wijzigingen na splitsen van een Vakvoorkeuze door middel van een tussenstijl of dorpel werden niet 

opgeslagen.  

CNC  

• Tijdens exporteren van CNC gegevens werden niet de merkaantallen getekend/gespiegeld van de 

geselecteerde serie opgenomen in het exportbestand maar in plaats daarvan de totaal aantallen.  



 

 

 

 

 

Projecten  

• In de dialoog Project->Kostenplaatsen konden percentages hoger als 100% worden ingevoerd welke 

vervolgens niet meer eenvoudig verwijderd konden worden, alleen via control+x. 

• De keuzelijst met artikelgroepen in de dialoog projectartikelen was verkeerd om gesorteerd. 

• De melding die werd getoond na het importeren van kozijnmerken was niet volledig alleen het aantal 

geïmporteerde merken werd weergegeven.  

Algemeen  

• De conversie applicaties werden in het Engels weergegeven.  

 

 

 

  



 

 

 

 

 

MatrixKozijn Hout versie 3.5 - Release 

Verbeteringen 

Rapporten  

• Nieuwe WKV Rapporten, Halve Randdetails met Randvoorkeuze Code en Halve Randdetails met 

Randvoorkeuze Detailnaam. Deze rapporten tonen de halve randdetails, voor laagrelief de hele 

randdetails en de doorsnedes van de tussenstijlen. Bij het detail wordt de positie en Randvoorkeuze 

Code of Detailnaam weergegeven. 

• U waarde, op de uitvoer wordt de waarde nu met maximaal twee decimalen getoond (was 3). 

• #28123, Spouwlat Contramalstaat B, keepgebieden uitrekenen en arceren. 

• Spouwlat Contramalstaat B, stippel/streeplijnen gebaseerd op doorsnede in het profiel tonen. 

• #28226, Spouwlat Contramalstaat B, initieel rapport toegevoegd. Orientatielijnen en Keeplocaties 

worden aangegeven. Rotatie doorsnedes naast profiel, detailopsomming en overloop aangepast. 

• Het wisselen tussen rapport layouts kan nu bij Extra -> Instellingen -> Calculatie Rapporten. Voorheen 

werd hiervoor een vraag gesteld tijdens de installatie, deze vraag is komen te vervallen.  

• Na openen van de calculatierapporten zijn meer van de tabs met geladen rapporten direct zichtbaar, 

voorheen waren slechts twee tabs zichtbaar. 

• Nieuw rapport, 1-Overzichten-Actieve Resultaten Filters, geeft een overzicht van alle filters die actief 

waren in de huidige calculatieresultaten. 

• Bij het centreren van details en doorsnedes op het subrapport van de werkvoorbereidingrapporten 

wordt nu de omvang 

• van de totale vorm van het detail of doorsnede gebruikt. Dus het totaalgebied van de doorsnede, 

• DXF-Blocks en maatlijnen.  

BIM  

• FABwindow v2, ondersteuning voor het attribuut voor stolpramen/deuren. Hiermee wordt 

aangegeven welk element eerst draaiend is. 

• FABwindow v2, de aan het paneelartikel toegevoegde eigenschappen TypeName en FamilyName 

worden opgenomen in het export bestand. 

• FABwindow v2 export, de contramallen van spouwlaten zijn nu aanwezig in de export. 

• FABwindow v2, het veld Software version bevat nu ook het buildnummer van de applicatie waarmee 

het bestand is aangemaakt. 3.50.6315 

• FABwindow v2, voor het oriënteren van profiel 2 in de Paneel/Rekwerk Combi's zijn de kolommen 

Oriëntatie en Y Positie toegevoegd. Als oriëntatie kan worden gekozen voor Binnenzijde of Buitenzijde 

ten opzichte van profiel 1. 

• FABwindow v2, contramallen voor neuten worden gegenereerd.  

• FABwindow v2: Voor alle artikelen die worden geëxporteerd naar FABwindow v2 worden de 

benodigde waardes voor Family Name, Family Type of Material Name nu bij het artikel zelf opgehaald. 

De export koppelbestanden sw_export* zijn komen te vervallen met uitzondering van het bestand 

sw_export_swingingtype.txt. 

• FABwindow v2: Voor glasartikelen worden de Family en Type Name waarden nu opgehaald van het 

artikel zelf. 

• FABwindow v2: Voor laagreliëfdorpels en neuten wordt de waarde voor Material Name opgehaald uit 

het veld BIM->Material Name.  



 

 

 

 

 

• FABwindow v2: Voor profielen met een neut toegekend wordt het neutgedeelte als apart profiel 

opgenomen in de uitvoer. 

• FABwindow v2, detail uitvoer vastglas: glas, glaslatten, ventilatieroosters. 

• FABwindow v2, contramallen kozijnprofielen. 

• FABwindow v2, doorsnedes kozijnprofielen. 

• Eigenschappen van de ventilatieroosters worden geëxporteerd als merk eigenschappen. 

• Eigenschappen van de glasartikelen worden geëxporteerd als merk eigenschappen. 

• FABwindow v2, extensie uitwisselingsbestand is nu: .IFW  

• FABwindow v2: Contramallen raam/deurprofielen waren niet correct geroteerd in het uitvoerbestand. 

• FABwindow v2: Als aftrekmaat voor glas bij gebruik van een ventilatierooster werd niet de netto 

hoogte van het rooster artikel toegepast.  

Grafische invoer  

• De standaard rasterafstand voor alle invoerstappen is aangepast naar 100. 

• Invoerstap - Kozijnvorm, het invoergrid staat voortaan standaard uit. 

• In de titelbalk en de merk keuzelijst in de grafische invoer worden de merkaantallen getoond 

gebaseerd op het actieve invoerfilter.  

• Beta implementatie glasdikte berekening gereed, in de productentabel bij de glasartikelen kunnen de 

kolommen: Opbouw Glas, Sterker Artikel en Zwakker Artikel in worden gevoerd. Project 

eigenschappen bevatten velden voor gebouwhoogte, windgebied en bebouwing. Weergave 

instellingen->Waarschuwingen->Windbelasting. Meldingen in calculatie voortgangsdialoog. In de 

invoerstappen vakken opties: Optimaliseer glas voor vak en Optimaliseer glas voor gehele merk.  

Calculatie  

• De positie van Hang en Sluitwerkartikelen op Laagreliëfdorpels zijn bekend in de calculatieresultaten 

zodat deze gegevens opgenomen kunnen worden in de elektronische bestellingen voor laagreliëf. 

• Artikel gewicht en Soortelijk gewicht houtsoort worden opgenomen in de resultaten voor de 

rapporten met gewichten van kozijnen en vakvullingen. 

• Tijdens het bepalen van de U-waarde worden de actieve resultaten filters toegepast. Voor onderdelen 

waarvan de artikelen geblokkeerd zijn, wordt de forfaitaire waarde toegepast (bijv. Glas). Bij 

ventilatieroosters boven glas wordt het glas vakvullend toegepast als het ventilatierooster 

geblokkeerd is. 

• U waarde, forfaitaire waarde inkoopdeuren aangepast naar 3.4 W/m2.K (was 5.7).  

Bibliotheek  

• Actie Update uit Bibliotheek toegevoegd voor Project->Conservering Combi's. 

• Hang en Sluitwerk Combi's, in de kolom 'Positie Y' kunnen nu ook formules en de variabele [L] worden 

toegepast.  

DXF Aanzichttekeningen  

• Papierformaat A5 is toegevoegd bij het onderdeel printerinstellingen. 

• Nieuwe uitvoer optie: Aanzichttekening Sjablonen->Kolommen->Vak Voorkeuzes- Hang en Sluitwerk 

zonder aantallen, opsomming van Hang en Sluitwerk in het merk zonder hierbij de exacte aantallen te 

vermelden.  

• De doorsnedes naast en in het kozijnen tonen nu alle spouwlatten van de rand.  



 

 

 

 

 

CNC  

• Bij de invoer van Hang en Sluitwerk artikelen in de Hang en Sluitwerk Combi’s is de kolom 'Achterhout 

Draaideel' toegevoegd. 

• Als er geen uitvoerlocatie is ingevuld bij de CNC instellingen komt hiervoor een melding tijdens de 

actie genereren CNC resultaten en de actie kan pas worden uitgevoerd als de uitvoerlocatie is 

ingevuld.  

• Werkvoorbereiding  

• Op Spouwlat Contramalstaat B wordt het te kepen gedeelte nu ook weergegeven in de 

spouwlatdoorsnedes.  

• In Hang en Sluitwerk Combi’s kan voor Hang en Sluitwerk artikelen nu de waarde Achterhout worden 

ingevuld. Deze waarde kan worden gebruikt door de CNC applicaties voor het positioneren van de 

bewerkingen. 

• Ondersteuning CNC export voor Rond/Getoogd. De volgende situaties worden ondersteund: Volledig 

Rond (Kozijnprofielen), Getoogde/Korfboog bovendorpel (Kozijn-, Raam/Deurprofielen (inclusief 

stolpstellen)). Geen ondersteuning voor Hang en Sluitwerk op de onderdelen.  

Projecten  

• Bij de projectartikelen zijn kolommen toegevoegd voor de invoer van: GTIN, Wijze van inkoop, 

Ongemonteerd Leveren, Optimalisatie, Hoeveelheid Colli en Omschrijving Colli. 

• Actie Update uit Bibliotheek toegevoegd voor Project->Conservering Combi's. 

• Actie Update uit Bibliotheek toegevoegd voor Project->Resultaten Filters. 

• Actie Update uit Bibliotheek toegevoegd voor Project->Hang en Sluitwerk Keuzes. 

• In de merkenlijst is een actie toegevoegd 'Hernummer merkenlijst gebaseerd op merkomschrijving'. 

De merken worden met deze actie gesorteerd op de kolom Omschrijving en vervolgens oplopend 

hernummerd. 

• Breedtes van kolommen Code en Omschrijving in alle keuzelijsten van het eigenschappen venster van 

de grafische invoer zijn nu op de juiste afmeting ingesteld. 

• Projectartikelen, nieuwe velden CE en U waarde gerelateerd worden ondersteund: Uw, Psi, LTA, LTZ, 

RW, RW_C en RW_Ctr. 

• Projectartikelen, nieuwe velden BIM gerelateerd worden ondersteund: Family Name, Type Name en 

Material Name. 

• Nieuwe dialoog, Project->Knooppunt Combi's.  

• Veld dikte voor inkoopdeur artikelen toegevoegd.  

Werkvoorbereiding 

• Voor de sponningfiguurtypes Muursponningen en Omfrezingen is het tabblad Naamgeving nu 

beschikbaar. De hier ingevoerde gegevens kunnen worden gebruikt door CNC aansturingen. 

• Minimale toegestane breedte en/of hoogte voor doorsnedefiguren is nu 2 mm.  

Productentabel  

• Maximale invoerlengte van artikel bestelcode is aangepast naar 255 karakters.  

Algemeen  

• Het (per ongeluk) sluiten van de Rand Voorkeuze dialoog door gebruik van de Escape toets is niet 

meer mogelijk. 

• Prijzen van de projectartikelen kunnen als negatief bedrag worden ingevoerd. 



 

 

 

 

 

• In de titelbalk van de applicatie wordt nu informatie getoond over gebruikte productentabel database, 

server en gebruikersnaam. 

• In de titelbalk van de applicatie wordt nu ook het versienummer weergegeven. 

• Tijdens de installatie wordt de standaard waarde voor de manier van doorvoeren van wijzigen aan 

project vak en randvoorkeuzes ingesteld op: Wijzigen aan project voorkeuzes worden altijd in het 

gehele project doorgevoerd. 

• In de artikellijsten van de Rand Voorkeuzes is het nu mogelijk om de juiste spouwlat te selecteren voor 

de berekening van lengte artikelen. 

• Ondersteuning spouwlat knooppunt sjablonen en de bijbehorende acties zoals merksjabloon 

toekennen. 

• Standaardwaarde voor Hoek snap naar verlengde en snap naar ortogonaal aangepast naar 15. 

• Menu overzicht pagina's voor project en bibliotheek herzien, volgorde onderdelen aangepast en 

arcering toegevoegd voor duidelijker afscheiding verschillende keuzes. 

• Volgorde van de onderdelen in het pulldown menu Project herzien. 

• Bibliotheek/Project menu pagina's herzien en arcering toegevoegd om en om voor betere 

leesbaarheid pagina. 

• Instellingen voor 'hanteer opdek' zijn niet langer aanwezig in raam/deur combi's en inkoopdeur/raam 

vak combi's. Ingevoerde opdekwaardes worden automatisch toegepast. 

• De tabbladen spouwlatten en artikelen/blocks in de randvoorkeuze zijn samengevoegd tot één 

tabblad met alle drie de invoergrids. 

• Licentie, module 64 toegevoegd voor het afschermen van nieuwe spouwlat functionaliteit. Zonder 

deze module zijn de beperkingen: Maximaal twee spouwlatten kunnen worden ingevoerd, de vorm 

van de spouwlat kan niet via de doorsnedes worden aangepast. 

• FABwindow v2, configuratiebestanden v2 opgeschoond en locatie aangepast naar 

BIM\FABwindowXML_v2  

• Bij roteren of spiegelen van spouwlatten met aangepaste figuren werd het invoegpunt mee geroteerd. 

• Detail van het kozijn werd niet getoond in de invoerstap Werkvoorbereiding als er een spouwlat met 

aangepast doorsnede figuur werd toegepast. 

• De installatie maakte geen snelkoppelingen aan voor de applicaties in Tools, zoals bijv. Conversie 

Stambestanden. 

• Zoeken in de artikel selectie dialoog werkte niet. 

• Afmetingen kolommen in export dialoog werden niet onthouden. 

• Conversie van stambestanden werkte niet in alle situaties correct.  

  



 

 

 

 

 

Oplossingen  

Grafische invoer  

• Instelling voor weergave Bibliotheek of Project tab in invoerstappen Vakken en Randen werd neit 

apart onthouden.  

Vakvoorkeuzes  

• Tijdens het kopiëren van Vakvoorkeuzes werd er aan tussendorpels en tussenstijlen een code 

toegekend welke zichtbaar was in de calculatie voortgangsdialoog.  

DXF Aanzichttekeningen  

• Resultaten Genereren->Maatlijn opmaak, de instellingen voor kozijnen en vakken werden verwisseld 

tijdens opslaan.  

Werkvoorbereiding  

• Toepassen van spouwlatten bij ronde kozijnen gaf een foutmelding in de werkvoorbereiding.  

Projecten  

• Tijdens het toevoegen van bestaande artikelen aan de project artikelen werd niet altijd de prijstabel 

geïmporteerd. 

• Wijzigingen aan de conserveringen werden niet altijd direct getoond in de voorbeeldweergave van het 

kozijnmerk. 

• Kopiëren van merken met een hoge waarde als peilmaat was niet mogelijk zonder de peilmaat waarde 

aan te passen in de kopieer dialoog. 

• Wijzigingen in het onderdeel sluitprofielen van project vakvoorkeuzes stolpstellen werden niet 

overgenomen in de merken die gebruik maakten van de desbetreffende project vakvoorkeuze.  

Algemeen  

• De berekening van de u waarde werkte niet correct voor het middengedeelte van stolpstellen als hier 

een negatieve of positieve overlap was opgegeven. 

• Als een vak volledig wordt gevuld door een ventilatierooster worden er geen lijnverliezen meer 

berekend voor het glas ten behoeve van de u waarde van het kozijn.  

• Het onderdeel Onderhoud is komen te vervallen. Alle gegevens die in Onderhoud werden vastgelegd 

zijn verplaatst naar Bibliotheek. Deze onderdelen bestaan nu ook op Project nivo.  


